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What do I Need?
This basic tutorial will offer you some guidance on how to prepare 
your InDesign fi le for export to the ePub format, and how to 
use Calibre to convert your ePub fi le to the Mobi format. The 
ePub format is readable by: the Kobo eReader, the Blackberry 
Playbook, the Barnes and Noble Nook, Sony eReaders, various 
Android and Linux devices, and many others. The Amazon Kindle 
supports the Mobi format.

The screenshots shown in the tutorial use InDesign CS 5.5 for Mac 
OS, Adobe Digital Editions, and Calibre 0.9.37. If you are using 
different versions of these softwares, some of the instructions and 
screenshots may be slightly different, but hopefully you can fi nd 
the right feature in your software version.

What is InDesign?
InDesign is a desktop publishing application which is available as 
a component of the Adobe Creative Suite. It is industry-standard 
software and is available for both Windows and Mac OS. 

You can gain access to this software by itself or as part of the 
CS suite by subscribing to the Adobe Creative Cloud, which is 
paid for by monthly fee.

Adobe: http://www.adobe.com

Adobe Creative Suite:
http://www.adobe.com/products/creativesuite.html

Adobe Creative Cloud: 
http://www.adobe.com/products/creativecloud.html

Adobe Digital Editions: a free e-book reader application
http://www.adobe.com/products/digital-editions.html

What is Calibre?
Calibre is a free, open-source e-book management application 
that is available for Mac, PC, and Linux. With Calibre, you can 
organize and manage an astounding number of different e-book 
fi le types in your library and sync them directly to a wide variety 
of personal devices. There is some amount of e-book editing 
that can be accomplished with Calibre, such as adding additional 
metadata. You can also convert DRM restriction-free e-books 
between different fi le formats.

Calibre already has a lot of support documents and tutorials 
written for its use that should be taken advantage of. 

Calibre: http://calibre-ebook.com

Calibre tutorials: http://calibre-ebook.com/help

Calibre demo: http://calibre-ebook.com/demo

How to Export Your Book as an ePub fi le with InDesign 
and your ePub as a Mobi fi le with Calibre
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Calibre demo: http://calibre-ebook.com/demo

Calibre’s tutorials also 
include information guides on 
the conversion of Microsoft 
Word and OpenOffi ce fi les to 
the ePub format.
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In the fi le format family, ePubs are unruly and reckless little brats. 
ePubs are book fi les written with XHTML and CSS, which, like web 
sites, make them fl uid and ever-changing. The exact same fi le will 
appear differently from device to device, depending on the physical 
size of those devices and their user-imposed settings. They will 
never, ever look exactly the same. Do not let this aggravate you. 
They are not fi xed, as well-behaving PDF fi les are.

Your InDesign fi le may be complete for print or PDF export, but you 
need to do additional preparations for ePub export, in an effort to 
retain as much of your original formatting as possible. (Although 
ePub and Mobi formats support complex formatting, some complex 
page formatting can be lost in conversion to other e-book formats 
due to the limitations of those formats.)

Some Words Before You Start...
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Always create and use Style Sheets for styling text. The consistent use of Paragraph and Character Style Sheets in your InDesign 
fi les is very important for your ePub export. For more information about the mechanics of setting up your InDesign fi le, e.g. using 
Paragraph and Character Style Sheets, see the DriveThru tutorial for InDesign in the Digital Tutorials and Templates page, located 
under Digital Titles in the Title Management section of the Publisher Knowledge Base.

The ePub export does not support layered or stacked 
objects in InDesign. If there are layered or stacked objects on 
the page, they will appear as individual, separate elements in 
your fi nal ePub fi le.

The Tutorial is Broken up into Sections:
1. Font embedding 
2. Preparing Your Cover Files
3. Managing Multiple Files with an InDesign Book File (.indb)
4. Document Structure

•  Adding Structure with the Articles Palette (for CS 5.5 and later)
•  Anchoring Artwork (inline and by drag and drop)

5. Custom Object Export Options (For CS 5.5 and later)
6. Building an Automatic Table of Contents (for CS 5.5 and later)
7. Adding Metadata
8. Exporting to the ePub Format

• The General Tab
• The Image Tab
• The Contents Tab

9. How to Export your ePub as a Mobi File using Calibre
10. More useful information

• Adding Structure with XML
• Adding Hyperlinks and Cross-References

11. What Do I Do Next?
12. I Need More Help!
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Font Embedding
While the Mobi format does not embed any fonts, the ePub format 
will embed Opentype (OTF) and most Truetype (TT) fonts. It does 
not support Postscript (PS) fonts. If you have Postscript fonts in 
your InDesign fi le, you will get an error upon export.

You can trust that the user’s reader will use its native fonts to display 
your content as well as it can. As such, it is recommended that you 
NOT embed any fonts all. It will not look exactly like your InDesign 
book, but it will still be readable. If you absolutely must embed fonts, 
only use OpenType fonts. 

If you care to, you can try to replace your Postscript fonts with 
comparable Opentype or Truetype fonts by opening <Find Font...> 
in the Type pull-down menu.
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Preparing Your Cover Files
Converting a cover fi le to ePub can be sloppy business if the cover 
is made in InDesign using text boxes stacked on top of linked or 
embedded images. ePubs cannot translate that layering and will 
show each object one after another as best as it can.

To get around this, you can do one of two different things. The fi rst 
and most obvious way is to make a cover fi le in an image editor, 
like Photoshop. You can place that fi le in your InDesign document 
or put it aside for later, when you export your fi le. There will be an 
option to include it at that time.

The second way, which is explained here, is to place an InDesign 
fi le inside your InDesign fi le. This is a feature available in CS3 and 
later. It’s just like placing a TIF, EPS, or JPG image fi le, but your 
source is a page from another InDesign fi le.

First, make a copy of the InDesign book fi le that contains your 
stacked covers. Then, in the fi le you are building for export, delete 
all the objects on your cover page(s). Next, place the same pages 
from your duplicate InDesign fi le that you just made. 

<Place> can be found under the File pull-down menu at the top of 
your screen. When the <Place> dialog box opens, navigate to the 
fi le you intend to place. If this fi le has more than one page, you will 
want to check <Show Import Options>, which will give you control 
over which page in the document you intend to place.

Once you have selected the correct page in your duplicate 
InDesign fi le, click <Open>. That page will be placed as one object 
in your current working fi le. 
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Managing Multiple Files with an InDesign Book File (.indb)
If you have built your project using only one, probably very long 
InDesign fi le, you will be able to export your entire book without 
issue. However, if you have built your project using multiple 
InDesign fi les, you will need to herd them together into one 
InDesign Book fi le (.indb). You will not be able to export your ePub 
as individual chapter fi les and then append them together later.

To make a Book fi le, open the File drop-down menu, navigate 
to and open <New>, and then <Book...>. A dialog box will open. 
Name your fi le and save it with your individual InDesign fi les. An 
empty Book pane will now appear on your screen with the name 
you have assigned your Book fi le.

Next, you will need to add your fi les to the book pane. Click the 
<+> sign at the bottom of the pane, or expand the menu from 
the top-right corner of the pane, and select <Add Document...>. 
Navigate to the location where you are storing your InDesign 
project fi les. If they are all in one location, you can select more 
than one fi le at once by holding down the <Shift> key. With your 
fi les(s) selected, click <Open>. All of your selected fi les will be 
added to the Book pane. The fi les in the Book pane should be in 
correct order as they appear in the fi nal project. To reorder, you 
can drag and drop the fi le names in the pane. The Book pane 
can automatically repaginate each fi le as needed, which will be 
refl ected in this pane.
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Managing Multiple Files with an InDesign Book File (continued)
If you continue working in your InDesign fi les, updating your 
content by adding and deleting pages, make sure to also update 
your InDesign book fi le. The Book pane can automatically 
update all of your chapter and page numbering, if you are using 
InDesign’s built-in pagination functions, i.e., special Placeholder 
Markers available under <Insert Special Character> in the Type 
drop-down menu. drop-down menu. 

If you need to update your Style Sheets and/or color swatches, you 
can update your primary InDesign fi le and then globally sync the 
updates to the rest of your Book fi les with the Book pane. To do this, 
update your primary fi le’s Style Sheets, then save it. Next, in the Book 
pane, make sure the document icon is set to the correct document. 
This is where you’re telling the Book pane to pull the updated styles 
and swatches from. Then select all the fi les to update. You can either 
click the double arrow at the bottom of the pane, or expand the menu 
from the top-right corner of the pane and select <Synchronize Book>. 
InDesign will automatically update and 
globally apply your style and swatch 
changes to your selected book fi les.

and select <Synchronize Book>. 
d
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For more information about basic InDesign pagination, see:

InDesign Help: Add Basic Page Numbering
http://helpx.adobe.com/indesign/using/layout-design-9.html

For more information about using Style Sheets, see the 
DriveThru Preparing for Print tutorial. You can also see:

InDesign: Paragraph and Character Styles
http://help.adobe.com/en_US/indesign/cs/using/WS9D351498-
DAAC-4be1-B4B8-2B6C72FF6CEDa.html
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Document Structure
Adding Structure with the Articles Paletteg

If you don’t set any structure or information hierarchy in your InDesign fi le, the ePub conversion will take matters into its own hands and 
use its own wacked-out logic to organize your content, from left-to-right and top-to-bottom. It doesn’t deal well with stacked or overlapping 
objects and will sort them out as best as it can, by that same left-to-right, top-to-bottom logic. As such, your exported fi le will not appear as 
you intend. For the most control and best results, you will want to impose a structure on your fi les, instructing InDesign to fl ow image and 
text content in a specifi c order. There are three ways to do this. Two are covered here:

• XML structure using tags (see the last page of this tutorial for more information)
• Using the Articles Palette (for CS 5.5 and later)
•  Flow all text using linked frames, with all graphics and images anchored either inline or by drag-and-drop

You have just made your fi rst article. Looking at your Articles 
Palette, you will see your front cover article with a list of page 
elements underneath. If you have a complex page, you can 
organize their order of appearance here. Also, if your palette is not 
expanded wide enough to view the entire description, hovering 
your mouse cursor over an element will give you a pop-up box 
with more specifi c information about that element.

The Articles Palette can be found under the 
Windows pull-down menu at the top of your 
screen. Open the Articles Palette and begin to 
add your content, starting with your front cover. 
With your Selection tool, select the placed 
InDesign cover. Then click the <+> sign at the 
bottom of your Articles Palette.

In the New Article dialog box that opens, name your 
article with a clear description. Then click <OK>.
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Document Structure
Adding Structure with the Articles Palette (continued)

Your assigned Articles will be specifi c to each 
document. Open a document, make your 
Articles, save, close, then open your next 
document and go through the process again.

You may have some pages in your InDesign fi le 
with multiple objects. You can group the objects 
on that page, and then add the entire grouping 
as one article. To do this, select everything on 
that specifi c page with your Selection tool, and 
then choose <Group> from the Object pull-
down menu. All of your selected objects will 
now behave as one object.

With your grouped object selected, repeat the 
Add Article process by clicking the <+> at the 
bottom of your Articles Palette. 

Again, name your article with a clear description. 
Then click <OK>.
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Your grouped object has now been added as one article in the 
Articles Palette. If you expand your Articles Palette, you will 
see that the grouped object is not only listed one object called 
<group>, but that another sublist appears underneath with each 
element listed.

hen click <OK>.Th

object has now been added as one article in the
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Document Structure
Anchoring Inline Artwork

When exporting an ePub, your images can shift around to some 
surprising places when left with no specifi c instructions. If you have 
not assigned places where your images should appear in relation 
to text or other objects, the export process will use its own logic in 
deciding where to put them. For example, images that should always 
appear next to certain paragraphs in your InDesign fi le may be 
bumped to the end of the chapter because the export process doesn’t 
know exactly where else to put them. The solution for reigning in 
this chaos is to anchor your image objects. This is important if your 
document structure is fl owing text with linked frames, less important if 
you are using an XML structure or the Articles Palette. 

As with everything, there is more than one way to anchor content. 
In some cases, you may want your images to appear inline, fl owing 
with your text. This requires anchoring your images into the baseline 
of the relevant text, as you might in a Microsoft Word document. It’s 
entirely simple. Just select the image box with your Selection Tool, 
copy it, then place a text cursor inside a text box in the spot this 
graphic should appear, and fi nally paste the image box in. 

  This is an example of a 
text box with an anchored 
image pasted into the 
baseline of text.

  This is the same text 
with the anchored image 
box selected using the 
Selection Tool. Notice the 
anchor icon at the top left-
hand corner.

The default pasting placement aligns the bottom of the image box 
to the baseline, or bottom, of the line of text. To fully ensure that 
this object will not shift in any text refl ow, you can assign a specifi c 
value for a baseline shift in the Application Bar. 

First, pull the inline box down as far as it will go. Then select that box 
with your text cursor. Change the value of the baseline shift in the 
Application Bar to meet your needs. The example shown has the top 
of the image box aligned to the top bar of the “T.” With this paragraph 
selected using the Type tool cursor, you may also want to adjust any 
before or after paragraph spacing using the Paragraph Palette or 
the same spacing options in the Application Bar. The beauty of this 
method is that these adjustments can be saved in Paragraph and 
Character Style Sheets, should you need to repeat this action.
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Document Structure
Anchoring Artwork by Drag and Drop

Sometimes anchoring an image into text is not the best option. There is another way to anchor images. You just grab a handle, then 
drag and drop the anchor to the text location. It leaves the working InDesign page appearance as is, with stacked objects.

First, click on the image box with your Selection Tool. You will notice a small solid blue box appear at the top of your image box. Click 
that box with your Selection Tool, then pull away and drop it near the text it should always appear adjacent to. As you pull, the cursor 
will turn into a tiny “T.” 

After you have dropped your anchor, the solid blue box at the top 
of the image box will turn into an anchor icon. Now when this page 
is exported, this image will always occur after this line of text.

If you have <Show Hidden Characters> turned on from the Type 
drop-down menu, you will see the spot the image is anchored to. 
It is marked by a hidden yen sign, “ ”.

If you have more than one image that needs to always appear 
together in your book, you can group them as one object, and then 
anchor the entire group into place. This tells the export process that 
after a specific place in the text flow, image A needs to occur followed 
by image B before any more text can resume.

After you have dropped your anchor the solid blue box at the top
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Custom Object Export Options
In CS 5.5 and later, there is a feature called Object Export 
Options. It allows the assignment of custom values for exported 
images and groups of images.

Make sure the image you are assigning custom values is selected 
with the Selection Tool. Then open the Object pull-down menu, 
and select <Object Export Options...>.

A dialog box will open with three tabs. Using these options, you 
can dictate custom rasterization, size, alignment, spacing of 
images, as well as create <Alt Text> tags for tagged PDF fi les and 
exported ePub fi les. (Prior to CS 5.5, <Alt Text> must be added as 
atrributes to XML tags.)

Creating Alternative Text that travels with your images can be very 
helpful to your fi nal product. It increases your book’s accessibility 
to readers who have visual or cognitive impairments and are using 
text-to-speech software. <Alt Text> can also be displayed instead 
of images, in circumstances where the user’s browser or reader 
cannot support the display or when the user has turned image 
viewing off. <Alt Text> is also searchable text.

For more information about using Object Export Options, see:

InDesign: Working with frames and objects
http://help.adobe.com/en_US/indesign/cs/using/WSa285fff53de
a4f8617383751001ea8cb3f-6f2fa.html#WS8c5bc4f64c7a4a3d-
7cbbfcee12dbd4ad69f-8000
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Building an Automatic Table of Contents
InDesign (CS 5.5 and later) can do this really cool thing. It can 
autogenerate a Table of Contents based on the Paragraph Styles 
of your book fi le(s). This can be used for print books as well as 
PDFs and ePubs. In a PDF, this generated TOC can also be used 
to create bookmark links. In an ePub, the TOC will be generated 
as TOC links in the book’s navigation menu.

If you have not dedicated any paragraph styles specifi cally for your 
chapter titles (and subtitles), now is the time to fi x that. Go ahead 
and make a paragraph style for your chapter titles, only using this 
style for this specifi c content in each chapter. In the sample book, 
it’s called “B Head.” 

If you are using separate InDesign fi les for each chapter, make 
sure to globally update all of your fi les from the Book pane. The 
name of the Style sheet must be exactly the same in each fi le for 
this to be effective.

Once you have styled your entire book with the new chapter head 
styles, go to the frontmatter of your document, where a TOC would 
normally appear in a print version. Insert a blank page or two. Then 
choose <Table of Contents> from the Layout pull-down menu. A 
dialog box will open, which at fi rst will seem confusing, but with a 
little exploration, it will make complete sense.
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Building an Automatic Table of Contents (continued)
The <Title> fi eld can be fi lled in with the title of the TOC page. 
“Contents” is the default. 

To the right of <Title> in the drop-down menu, <Style> refers to 
the Paragraph style that should be used for the TOC title. In the 
example book, it will be “A Head,” which has a slightly larger font 
size than “B Head.”

Under <Styles in Table of Contents>, <Include Paragraph Styles> 
refers to the chapter title paragraph style that occurs throughout the 
book. This is the part you just did. Scroll through the list of styles to 
the right, select your title style, and then click the <Add> button to shift 
the name of the style to the left-hand column.

Now that you have picked the Paragraph style that InDesign needs 
to look for to generate the TOC, you can further dictate how the 
new TOC should look. <Entry Style> refers to the Paragraph style 
that InDesign should use to style the generated TOC content. You 
can pick where to put the page number: before the entry, after 
the entry, or no page number at all. If you have specifi c Character 
styles that you want to apply to the chapter page numbers as they 
appear on the TOC or between the entry and the number (such as 
a style you’ve made that is just a dotted line), this is where you can 
specify those things. There is also a menu that lets you choose the 
autogenerated spacing between the chapter entry and the chapter 
page number, which is shown in the screenshot to the left.

Finally, under <Options>, you can check <Create PDF 
Bookmarks>. If you intend to export a PDF from this same fi le, 
InDesign will generate the PDF bookmarks automatically. 

You also need to check <Include Book Documents>. This tells 
InDesign that it needs to search for the applied Paragraph style 
in all of the fi les that are included in the Book pane (.indb) for 
TOC entries.
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An ePub text export of the book fi le with the autogenerated TOC 
navigation links will look like this:

Building an Automatic Table of Contents (continued)
Once you have fi lled out the <Table of Contents> dialog box, 
click <OK> to generate the Table of Contents. After “thinking” 
for a minute, your cursor will change into a loaded text cursor. 
Click on the page to unload the text box containing your new 
autogenerated TOC.

If you make any changes to your book, like chapter 
title changes or repagination, don’t forget to update the 
autogenerated TOC. This option is called <Update Table of 
Contents> and is located directly under <Table of Contents> 
in the Layout pull-down menu.

he text box containing your new
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Adding Metadata
Adding metadata is very, very important for your ePub fi le. Potential readers are text-searching online for new books to read every day. 
Your book’s metadata information and keywords are the text-searchable bits of information that will make a broader readership aware of 
your work. Think of your ePub as a miniature website; the metadata improves your Search Engine Optimization.

To add metadata, open <File Info...> in the File pull-down menu. 

A dialog box will open. This is where the book title, author’s name, book blurb, descriptive keywords about content and 
copyright information can be noted. Fill this out, then click <OK>. Save your fi le.

When a text ePub is exported, you will 
notice now that the title and author’s 
name now appear above the navigation 
links. (See the previous page’s 
screenshot of this pane to compare the 
difference.)

your work. Think of y
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Exporting to the ePub Format
Hopefully you’re now ready to export your InDesign fi le in the 
ePub format. If you have one fi le that contains your entire book, 
open your InDesign document, if it’s not open already. Then 
navigate to and open <Export...> from the File pull-down menu.<Export...> from the Fi

For a single fi le, <Export> will give you many format options in a 
pull-down menu. Choose <EPUB>, then click <Save>. Exporting 
from an .indb book fi le will not give you these fi le format options. b book fi le will not give you these fi le format

If you have multiple fi les managed by an .indb Book fi le, open the 
contextual menu from the top-right corner of the Book Pane, then 
navigate to and open <Export Book to EPUB...>.o and open <Export Book to EPUB...>.

The <Export> dialog box from the book palette looks exactly 
like the <Export> dialog box below to the left, except for the 
missing fi le format options.

Going forward from this point, there are no differences between 
these two ways of exporting, other than the ability to export an 
entire book from multiple fi les at once.
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Exporting to ePub 
The General Tab

A dialog box will open with three tabs. The fi rst tab is called 
<General>. You will want to check <Include Document Metadata>, for 
reasons already explained. 

Although it doesn’t appear in this screenshot, you may have the 
option of choosing your ePub version, either ePub 2.0 or ePub 
3.0. ePub 2.0 is recommended. It is an older format and will have 
a broader readership since not everyone has the newest tablet 
or device. However, ePub 3.0 better supports more embedded 
media, like audio, video and JavaScript. Your choice will depend 
on the contents of your InDesign fi le and how accessible you 
would like your book to be to folks with older devices.

<Add Publisher Entry> refers to the publisher’s information. You can 
list the publisher’s name or specify a URL for the reader to visit.

<Unique Identifi er> is one of the few required fi elds you will have 
to fi ll out. It refers to a unique attribute of the book, like an ISBN. If 
you don’t have an ISBN, you can leave this fi eld blank. InDesign 
will automatically generate an Indentifi er number for you.

If you have an InDesign fi le placed in your InDesign fi le for the cover, 
or have placed a fl attened image fi le, you can choose <Rasterize 
First Page> for the <EPUB Cover>. If you have a fl attened cover 
fi le elsewhere, not placed in the InDesign fi le, you can choose <Use 
Existing Image File>, and navigate to where that fi le is located.

<Ordering> refers to the reading order the export process uses to 
organize the book’s content. If there is no applied structure, the 
order will default to <Based on Page Layout>. If you have applied 
a structure with XML tags, the radio button for <Same as XML 
Structure> will be available. If you have applied your structure 
according to this tutorial, with the Articles Palette, the radio button 
for <Same as Articles Pane> will be available.

Under <Formatting Options>, the Book Margin can be set as Pixels 
or Ems. This distance is margin between the edge of the ePub page 
and the fl owing content. 

If there are Bullet or Number lists in the InDesign fi le(s) you will be 
exporting, you can give InDesign direction here for how the lists 
will appear when converted to HTML.
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Exporting to ePub 
The Image Tab

The second tab is called <Image>. This is where you give 
InDesign some direction about handling the conversion of images 
in your ePub.

<Preserve Appearance from Layout> should be checked. Doing 
this preserves any local InDesign formatting, like scale, rotation 
and skew.

<Resolution> 96 ppi is recommended and works well on most 
devices. 

<Image Size> should be set to <Relative to Page>, not <Fixed>.

<Image Conversion> can be set to only <JPEG>, only <GIF>, 
or <Automatic>, which lets InDesign decide for you as each 
instance occurs.
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Exporting to ePub 
The Contents Tab

The third tab is called <Contents>. The default format for content 
is <XHTML>. <DTBook> (Daisy Digital Talking Book) is an XML-
based ePub for the visually impaired. (If you intend to convert your 
ePub fi le to the Mobi format later using Calibre, do not choose the 
DTBook markup option because Calibre does not support it.)

Make sure to use the InDesign TOC style that you have created, 
whether you have left it named as <Default> or have edited it to 
have a specifi c name.

Choose breaks in your ePub document based on where Paragraph 
Styles occur, like Chapter Head styles. Choose the location of 
footnotes, if necessary. If there are any forced line breaks applied 
to your content, to eliminate orphans and widows in the print 
version, you should remove those breaks here.

The export to ePub process automatically generates CSS 
(Cascading Style Sheet) that travels within the ePub fi le. This is yet 
another reason why the consistent use of InDesign Style Sheets 
is so important. Check <Include Style Defi nitions> for InDesign 
to build CSS information based on your InDesign Paragraph and 
Character styles. If you have manually styled anything in your fi les 
without making a style sheet, check <Preserve Local Overrides> 
for InDesign to create additional CSS styling information.

<Style Names Only> will tell InDesign to include Style names in the 
CSS but with no supporting defi nitions.

<Use Existing CSS File> is for those brilliant enough to know how 
to write their own CSS, or for those persuasive enough to convince 
their friends to write CSS for them. Click <Use Existing CSS File> to navigate to and append an external CSS to your ePub document.
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to write their own CSS, or for those persuasive enough to convince
their friends to write CSS for them. Click <Use Existing CSS File> to navigate to and append an external CSS to your ePub document.

Once you have completed your information in the three export options tabs, click <OK> to export your fi le. If you have checked 
<View EPUB after exporting> in the <General> tab, your completed ePub fi le should launch whatever your default ePub fi le viewer 
is. If you don’t have one, there are many to choose from, some of which are free, like Adobe Digital Editions: http://www.adobe.com/
products/digital-editions.html. 
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How to Export Your ePub as a Mobi File with Calibre
Test your ePub fi le on as many readers and devices as you 
possibly can after export, to make sure it looks the way you 
want it to. When it’s complete to your satisfaction, you can then 
prepare to export it as a Mobi fi le. First, add your ePub fi le to 
your Calibre library. Click the <Add books> button at the top-
right corner and then navigate to the location of your ePub fi le 
on your computer. Select the fi le to add it. While Calibre adds 
this fi le, you will see a temporary dialog box open, telling you 
that Calibre is working on the task.

When Calibre has completed processing the fi le, your book title will 
appear in your library list.

After you have added your ePub, you will need to double-check 
your book’s metadata. Click the second icon at the top of your 
window, <Edit metadata>. 
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How to Export Your ePub as a Mobi File with Calibre (continued)
A dialog box will open. You can proceed with updating your book’s 
information here. You can add additional tags, update the book 
cover, and even add publication dates. Click <OK> to save your 
input when you are fi nished.

After you have updated your metadata, you can begin converting 
you book to Mobi. Click the <Convert books> icon at the top of 
your window.

Besides using Calibre to update your metadata, you can also use 
it to insert a cover image in your ePub fi le.



22

How to Export Your ePub as a Mobi File with Calibre (continued)
The Convert dialog box will open. On the left-hand size, there will 
be a list of tabs that you will click to provide more specifi c format 
setting information. The default tab opens with <Metadata>.

If Mobi is not already set as the output format, choose it from the 
drop-down menu at the top-right hand corner of the dialog box.

If your book cover image does not appear in the cover image 
viewer, you can manually navigate to a JPG fi le stored on your 
computer and add it, or click <Use cover from source fi le> to 
include the cover image from the ePub fi le.

The next tab is <Look & Feel>. The only setting you may want to 
adjust here is <Remove spacing between paragraphs>. Removing 
the spacing between paragraphs adds an indent to the beginning 
of each paragraph, which makes them look more like they would 
appear in a printed book. This is formatting is your choice.

Otherwise, please do not enable <Disable font size rescaling>; 
the user of the device will no longer be able to enlarge the text for 
readability. Also be wary of embedding any font families that are 
not universally available on most machines and devices, as font 
substitutions will likely occur.
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How to Export Your ePub as a Mobi File with Calibre (continued)
The next tab is <Page Setup>. In the top left-hand corner of the 
dialog box, your Input format should automatically be recognized 
as <EPUB>. Set your Output profi le to <Default Output Profi le>. 
Set your Input profi le to <Default Input Profi le>. If you are inputting 
and exporting a fi le for personal consumption, and know exactly 
what device the conversion should be tailored to, you can specify 
those devices here. However, in this situation, your Mobi will be 
read on unknown devices, so it’s best to choose a default that 
covers a range of devices.

After you have selected your device profi les, click the next tab, 
<Table of Contents>. Click to enable <Force use of auto-generated 
Table of Contents>.
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How to Export Your ePub as a Mobi File with Calibre (continued)
The last tab to click is <MOBI Output>. If it is not selected, make 
sure to select <Old> for MOBI fi le type. This will make your Mobi 
readable by an older and larger range of Amazon Kindles.

Now that you have completed adding fi le format specifi cs, click 
the <OK> button at the bottom right-hand corner of the dialog box. 
Calibre will begin to convert your fi le, automatically adding it to 
your library.

While Calibre is working, the wheel icon at the 
bottom-right hand corner of the library window 
will spin. If you click <Jobs> to the left, you can 
see the conversion progress of your fi le, or many 
fi les if you have a batch queued.

Now your Mobi fi le has been added as an additional fi le format for 
your book. To view the converted fi le, click the <MOBI> text link in 
the fi le format list under the book cover image. Calibre will open 
another window, in which you can scroll through and see what the 
converted Mobi fi le looks like.

<Path> is the way to fi nd where Calibre has saved the new Mobi fi le 
on your computer. Click the <Click to open> text link. Calibre should 
open a new window displaying the location of your Mobi fi le.

ny 
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More Useful Information
(not covered in this tutorial)

Although it’s not covered in this tutorial, structuring your document 
with XML tags is very useful knowledge to have if you have an 
InDesign version prior to CS 5.5. It will be easier and possibly 
more effective for structuring your document than text fl ow with 
linked frames and anchored elements.

For more information about XML tags and structure, see:

Indesign: Tagging Content for XML
http://help.adobe.com/en_US/indesign/cs/using/WSa285fff53dea4f
8617383751001ea8cb3f-6cf6a.html

InDesign: Structuring Documents for XML
http://help.adobe.com/en_US/indesign/cs/using/WSa285fff53dea4f
8617383751001ea8cb3f-6ce7a.html

InDesign also lets you build cross-references and hyperlinks in 
your document that allow the reader to jump from place to place 
inside the same document, to locations in other documents, 
or to websites. These can be exported in both PDF as well as 
ePub fi les. 

For more information about Cross-references, see:

InDesign: Cross-references
http://help.adobe.com/en_US/indesign/cs/using/WS9AD9A0DA-
E10F-4d1e-9EB2-999FB61D21E8.html

For more information about Hyperlinks, see:

InDesign: Hyperlinks
http://help.adobe.com/en_US/indesign/cs/using/WSB152EA6F-
30D9-417c-9E16-A2C492C04892.html
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I Need More Help!
To contact Print and Digital Design Services, please email 
pauline@onebookshelf.com. Your input and questions will help us 
improve this tutorial, so it answers more questions for everyone.

If you have decided that you don’t care to do your own fi le layout, you 
can fi nd people with professional skills and contract them to create 
your print fi les. The cost of this work depends on how much of the 
work you do yourself before handing it over. You can fi nd freelance 
layout professionals at sites like www.upwork.com.

We can also recommend someone for layout if you would like. 
Please contact Publisher Services for details.

What Do I Do Next?

Once you have fi nished producing and testing your new digital 
edition formats, you’re ready to upload! 

Log into your DriveThru account, and go to your Publisher Hub 
on the Publish page. If you have not already set up a title record, 
go to TITLE MANAGEMENT/Set up a new title to do so. 

If you have any questions or need more information about how 
to proceed with fi lling out this form, you may also fi nd it helpful 
to follow our Book Walkthrough located in the Publisher 
Knowledge Base.

After a successful upload, you can choose to activate your title for 
live sale! How exciting!
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